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A note on Olympus camera menus.
If you press the MENU button you will see, arranged along the left side of the monitor, from the top
down, a camera symbol with the number 1 and then another with the number 2.
This is exactly the same system used by other manufacturers like Canon, Nikon and others and is
very easy to work out.
If on a menu option page with a camera symbol, the settings you can access will usually affect
things that you need to set before taking a photograph.
Then there is a Playback symbol. This contains things you change after the image has been taken –
like how many images are displayed in lightbox view, what information on the shooting parameters
are shown over the image and so forth. You can also edit images in-camera using settings on this
menu.
Then you will see a symbol of two gears.
This is where you tell the camera how to use all its various settings – just like setting up your
Smartphone. You will not usually use these adjustments from shot to shot but they are parameters
that affect how the camera responds to things like AF, release button presses, function buttons etc.
Like the Canon Custom Function menu and the Nikon Set Up menus, these are often sub-divided
into sub-sets of functions you can adjust.
For example, if you want the AEL lock button to activate AF, this is a Function you want to change
on a button. Soooo, go to the “button” menu (B) and find Button Function. You then get shown all
the options you have for changing Button Functions.
How hard is that – really?
Finally, on the OM-D E-M1 (original) there will usually be a Spanner symbol. Think of this menu
as the toolbox (why it is a spanner you spanner!) to set core things like date/time and update
firmware.
There is one hidden item (by default) that pertains to settings for the older Olympus accessories that
used the power port below the hot shoe. If you still use the Olympus stereo mic or the older
PENPAL wireless sharing gadget, you may wish to activate this menu page. It is in the toolbox,
under Menu Display. (the 6th item down).
Throughout this and my other menu guides I have added notes sharing my thoughts and reasons for
the settings I use.
Your needs may differ. Hopefully, however, you can gain a better understanding of what each
setting does and how you can make the camera work as you prefer.
Items in bold type show the menu description and setting on my camera.
All that said, lets get to it.
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CAMERA MENU 1
Card setup/Format and Reset/Myset should be easy enough. I like it here, the first item on page
one. As the rest of the camera universe buries formatting in the set up menu, Olympus moved it
there on the E-M1 mark ii and the later models. It lived here happily ever since the E-1...sigh!
Picture mode I tend to use Natural. If you are shooting kids parties, an Eastern Tamil/Hindi or
traditional African wedding then you could try Vivid but that tends to overdo sallow skin tones.
Your mileage may vary but using natural allows you the most leeway to either saturate or diminish
colours in post production in my view. Of course if you only shoot in RAW file format then this
setting can be changed in post and where it is makes no difference if you like first adjusting the
colour mode when viewing RAW files..
Image size settings (that triangulated pixel symbol) >
Still picture JPEG setting is LF (large fine)
Movie is MOV FHD F 24p
Image Aspect is normally 4:3. This uses the entire image sensor area. I crop to other aspect ratios
in post.
Digital Tele-Converter is usually Off. This captures an image which has been digitally enlarged by
a factor of 2. Effectively, this gives you twice the focal length of any lens attached. Use with caution
and only when you have no other option to grab that little Tiger cub on the hillside (or similar).
Quality varies from totally acceptable to lousy depending on the light and subject. A great option to
remember in the back of the mind when stuck without a longer lens and you must get the shot..
Release mode/self timer/Interval timer. This last option on page 1 of the camera settings menu
duplicates the function available on the upper left button of the camera body. This lets you adjust
Release mode/self timer/Interval timer.
You can also set this via the Super Control Panel - SCP.
Press OK and tap the release mode square – twirl the front dial to pick a setting and touch the
shutter button to confirm your choice.
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CAMERA MENU 2
Bracketing – as needed. Also available on top left button and via SCP.
Bracketing choices include flash, exposure, ISO, ART, white balance and focus bracketing. If the
Focus bracketing option is greyed-out, you may not have a compatible lens fitted. Only native m43
lenses work with focus bracketing. Nope, nothing with an adaptor can focus bracket automatically.
HDR – As needed. Also available via top left button or SCP.
Keystone Comp. My all time favourite for buildings and product shots. See my blog article “The
death of the shift lens?” When set to On you can swing or tilt and then move the sensor to correct
perspective lines using the input dials and the arrow pad. No need for a shift lens! The OM-D (mark
1) gives either swing or tilt. The E-M1 mark ii gives both. View cameras? What are those...?
Multiple Exposure – as needed. The option has two custom options to set the number of frames
and the Gain. If Gain is On it changes each frame to ½ brightness. If Gain is Off the images retain
the exposure level you set for them as they are stacked.
Overlay. The overlay option will only be active if you are shooting in RAW and this will stack the
number of images selected into a single RAW file.
Anti-Shock/Silent – as needed. The Anti-Shock setting lets you programme a delay between the
shutter being pressed and the exposure taking place at speeds below 1/320 sec. This is used when
even the smallest movement may affect image sharpness as when shooting attached to a high
magnification microscope or a telescope. The Anti-Shock mode affects the mechanical shutter and
the Silent one is used if using the Silent shutter mode. Kind of logical...
RC Mode – As needed (Off/On). Activated when I am using off-camera Olympus R flash units and
I then use the dinky little FLM flash unit – which you most likely tossed back into the box as a
useless artefact - to act as the commander.
See? All these Camera 1 and Camera 2 menu options you will need to set before you actually take
a photograph.
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PLAYBACK MENU
Slideshow – As needed. This sets up a slide show of the images on your card and you can adjust the
interval between slides as well as pick from built-in BGM (BackGround Music). In the options you
can select to include only stills or videos or all the files on the card and also how long it takes
before looping the show. Your mileage and use of this feature may vary...
Rotate Image on playback – On. I shoot a great number of vertically orientated images and hate
seeing it scrunched on the screen with huge wads of black either side. With this On the image is
shown in the orientation it was shot in – and is full screen. OK, you do have to turn the camera to
see it but that is a small price to pay in my view for not having to zoom the image all the time.
Edit Lets you apply some common edits to images already on the card. Press OK then you will be
asked to Sel Image. Press OK and then RAW Data Edit or JPEG edit or the Voice note recorder.
There are options in this to change images to monochrome, set filter effects and more. Similar to the
Nikon Retouch menu. You can also start a slide show from here as well as print directly via USB to
a Pictbridge compatible printer.
Changes are applied to a copy of the image which is stored in the next available space on the card.
So if you edit image 3 of 567, the edited image file will become number 568. The option I use a lot
on this menu page is the voice note function.
However, you do not need to dive into the menu to do this. Press playback then OK and the editing
options will be made available to you.
From these you can use the Mic symbol to record a voice note (names of subjects in image, location
etc.) to aid you when cataloguing the image in post. You get 30 seconds. Be aware, however, that
the voice note plays as soon as you view the image so you may wish to first adjust the volume of
the camera speaker. If you forget and a voice note starts blaring from the camera, simply rotate the
front dial to switch to another image and then change the volume settings. Your use of these
functions and mileage may vary...
Print Order. The industry standard DPOF option available on all cameras and supported by most
printers post 1998 which I have seldom seen used. Lets you indicate how many prints you want
from each image and if you insert the card into a photo kiosk the selected number of prints will
automatically be generated. Ho-hum... If you use this at any stage remember to reset the entire Print
Order data set otherwise you will get the same number of prints generated the next time you visit a
kiosk with your camera card – if you insist on inserting your card into a public slot... Also works on
any PictBridge compatible printer.
Reset Protect If you have used the protect image option (the key symbol option seen when pressing
OK after playback) to stop accidental erasing of vital images in the camera, you can reset all of the
protection instructions using this option.
Connection to Smartphone Choosing this option by highlighting and pressing OK starts the Wi-Fi
system of the camera. It is faster to tap the WI-FI wording on the top left of the camera screen.
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SET UP MENU (GEARS MENU)

Option set A for AF/MF (Auto Focus)
AF Mode > Still Picture and Movie is usually set to S-AF (Single Auto Focus). You can rapidly
change this in the SCP or by using the button on the top left of the camera.
Full time AF > Off. If switched on any OM-D camera chews batteries and tries to focus all the
time, even with a body cap or lens cap on the lens, When Off the AF only activates when you
lightly press the shutter button.
AEL/AFL>SAF>Mode 1. Starts AF on light press and locks exposure, takes photo on full
depression of shutter button.
AEL/AFL>CAF>Mode 2. Starts AF when lightly pressed but only grabs exposure and shoots
when fully pressed. I find this leaves the back buttons free for other important stuff when shooting
sports.
AEL/AFL>MF>Mode 1. Locks metering on a light press of shutter and takes shot when fully
depressed.
Reset Lens>Off. This re-sets the focus of the attached lens on the camera body when the power is
switched off. If shooting videos and you need to power down to save battery, this will take your
focus off the speaker's podium or the nesting site of a bird as but two examples. If this is off then
the focus will stay set where it was. Also cuts power consumption overall. Your choice may vary
here.
Bulb/Time focusing>On. Lets you manually adjust focus during bulb and live time shooting on the
lens ring.
Focus ring>Anti Clockwise (Default). Same direction as the OM series lenses from infinity to
close up. Four decades of focusing muscle memory is hard to break.
MF Assist> Magnify>On When focusing manually the central portion of the image is
automatically enlarged when the focus ring is rotated.
MF Assist> Peaking>On Uses highlights around in-focus items to make it easy for you to nail the
focus point you want.
[---] Set Home>All groups set to middle of array With this set, no matter where your AF target is,
a short press of the OK button will get it right back to where you set it to go with this setting.
AF Illuminator>Varies (Options are On/Off) This can shine a red light (or not) from the camera
body to assist AF in low light. Useful in some cases, irritating in others. Use as required.
Face Priority>Varies Normally for weddings and social occasions it is on with (I) to focus on eyes
as well. For general scenes in news and sports it is off.
AF Area pointer>On Shows you where the camera is focusing with a bright green box if on. Nice
to know where it is looking...
C-AF Lock>Varies Usually Normal. With sport with players/objects often moving/running in front
of the target I set it to Low. For high speed mechanical action (race cars, aircraft on their own in the
frame) I set it to High. For children running to the camera without obstructions I would use High.
MF Clutch>Operative If you have an OM-D line lens with a manual focus clutch this ensures it
does what it is designed to do. If you often bump the clutch into MF and get irritated by this, switch
the function to Inoperative (off) here. I personally love using it to pull focus in video.
This PDF was originally downloaded at no charge from www.flightlevel42.co.za
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Option set B (For Button/Dial/Lever)
Button Function>Fn1>AF Area Select Quickly calls up option to move AF point
Fn2>Multi Function Lets you quickly select curves or colour creator and other
functions.
Rec Function>Record Why disguise your video record start/stop button?
AEL/AFL Function>AEL/AFL Seems daft to set this when I have AEL on the
shutter button but, if you use this with the metering AEL zone option set elsewhere
you can get an instant spot meter (or Centre Weighted or SpotHi or SpotLow) on the
AEL button. That's why I have it set this way here...
Top body button>One Touch White Balance Aim camera at a white surface and
press then press shutter – instant white balance correction for mixed Kelvin lighting
conditions.
Lower body button>Depth of field preview Stops down lens to pre-set aperture for
depth of focus preview in the viewfinder.
<^> Four way controller> [---] Allows you to move focus points with arrow pad
keys.
Bfn1>AEL/AFL Sets HLD7 battery grip buttons to mirror the setting on the camera
with the camera turned vertically.
Bfn2>[---] Sets HLD7 battery grip buttons to mirror the setting on the camera with
the camera turned vertically.
Lfn>AF Stop Lets me lock AF when covering fast action if needed by pressing the
lens function button on a Zuiko PRO lens.
Dial Function>P>Front Dial +/-, Rear dial Ps
>A>Front Dial +/-, Rear Dial Aperture value
>S>Front Dial +/-, Rear Dial Shutter speed value
>M> Front Dial Aperture Value, Rear Dial Shutter speed value
>Menu> Front Dial horizontal movement, Rear Dial vertical movement
>Playback(>) Front Dial Prev/Next image, Rear Dial Zoom/Thumbnail view
Dial Direction>Dial 1>Exposure>Dial1 Increases the value as dial is turned to the right.
>Ps>Dial1 Increases shutter value/opens aperture as you turn it to the right.
Mode Dial Function> Change what each position on the mode dial does. Mine is standard.
Lever Function>Mode 1 Setting to this leaves the functions on the control dials as I set them for
normal use. Switch the lever to position 2 and the front dial instantly changes ISO (and so many
moan that OM-D cameras do not have an ISO button...!) and the rear dial changes White Balance.
There are 5 modes to play with. Find the one that works for you.
Mode Dial Function. Only available if the Lever Mode position 2 is off.
Lever Mode position 2>On This lets you change the function of buttons on the top left of the
camera when you flick the lever to mode 2. The buttons then change flash compensation and flash
mode as well as Bracketing mode and number of bracketed frames and their EV steps. Cool.
This PDF was originally downloaded at no charge from www.flightlevel42.co.za
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Option set C (Release/Continuous mode selections)
Release Priority S>Off This ensures that the shutter will not fire unless something is in focus. As
you usually use the S AF mode for portraits, weddings, products and other stuff that must be tack
sharp, this is a good idea to me.
Release Priority C>On/Off I change this if I am doing specific action where I need sharp shots all
the time – like sponsored race cars, athletes or football players for their agents. If On when shooting
those, the camera will track focus and only release if it deems the subject is sharp. With it off, you
can pick the moment to fire and it obeys. Your mileage may vary depending on your needs. For
Birds in flight or other action set this to On and you will not get many (if any) out of focus shots as
it tracks the bird.
L fps>5fps No logical reason for this setting other than it is what my Nikon F5 and E-3/5 could
give and plenty fast enough for most use when doing human based sports (except Touch). Set what
you like.
H fps>10 fps The fastest you can get on the mechanical shutter of this camera. So if you want H
rates, then, as the saying goes, go huge or go home.
Silent Shutter Low fps>5 fps I keep this at the same as the mechanical shutter rate. Why add
things to remember?
Silent Shutter H fps>11 fps See comment about the 10fps setting above.
Image stabiliser>
Still Picture>IS AUTO At this setting the camera automatically compensates for panning
and tilting and de-activates either if needed. If set to IS1 or IS 2 you need to remember
which is which and set the appropriate option if you suddenly decide to pan. I let the
electronic genies sort those decisions. After all, I did pay for their abilities...
Movie>M IS 1 With this setting the camera uses the sensor shift plus digital stabilization
when you are capturing movie footage. It clips the scene by a few pixels and you lose that
last word in crispness of detail (go on, tell me you can really see the difference...) but then
you do not get the slight wobble of the image when changing direction of pan or movement.
Image stabilization>On Only reason to put it off is if you on a tripod or think you can hold the
camera steadier than it can.
Halfway Release with IS>On This activates the stabiliser when you half-press the shutter. Lets you
see the subject without it jigging about. You can save a miniscule amount of power by setting it to
Off. I don't bother.
Lens IS priority> Off/On If you have a lens with an optical stabiliser built-in, set to on. If not, set
it off.
Release Lag Time>Short If set to normal the camera takes a fraction of a second to respond to the
shutter. Set to Short it is far more responsive – instantaneous in fact. However, the Short setting
uses more battery power than Normal. If doing landscapes and still subjects all the time, you may
prefer to save on batteries. I need instant responses from the camera and use an HLD7 and two
batteries almost all the time. Your call...
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Option set D (Display/Sound/PC)
HDMI>HDMI Out>1080i If connecting to a large screen via an HDMI cable, why not give the
best signal possible?
HDMI Control>On With this on you can power the camera on and off and flip through images
with the screen/HDMI device remote control.
Video Out> PAL My country uses PAL TV signals. Set according to your locality.
Control Settings>
iAUTO>Live Guide – Live SCP
P/A/S/M>Live SCP
ART>Art Menu -Live SCP
SCN>Scene Menu-Live SCP
Each press of the INFO button while using each mode above will display the settings selected. OK.
OK! Yes, I do love the live Super Control Panel (SCP). You may not.
Info Settings
Playback Info>Image Only-Overall-Histogramme-Highlight/Shadow-Light Box
Each time you press INFO after displaying an image you have taken the display will cycle through
the settings you choose here.
Live View>Image only-Custom 1 – Custom2
If you set Custom1 you get a red overlay on blown highlights and a blue overlay on blocked-out
shadows in real time while previewing an image on the screen or in the viewfinder if you cycle the
INFO button
Custom2 displays the level gauge on the next press of the INFO button.
Thumbnail settings> 4 – 25 – Calendar
After displaying an image for review, turning the rear dial to the left will display a 4 thumbnails and
then 25 before showing a calendar display. Choose the options you like.
Displayed Grid>Off After 4 decades in this business I reckon I should know where the
intersections of the thirds are...I fancy that not using this balances-out the power used by the use of
Short in the release lag setting. ;-)
Picture Mode Settings> All Why switch off an option you paid for? However, if you only use one
or two and never the others, you can limit which ones are available on the SCP and Picture Mode
menu option here. Will save you seeing picture modes you do not wish to see or use.
Histogram Settings> Highlight 250 Shadow 5 Aha! Why this? Well, if you couple this setting to a
change of the Live View INFO setting to Custom 1 as described above, you will get the option to
show the blown out areas of your shot in the viewfinder (or rear screen) in red as you preview the
image. With the highlight warning set to display at 250 (and not 255) you will have a bit of
“headroom” built in to your exposure if you avoid having any highlights in red in the preview.
Blacked out shadows will show as blue but with a similar amount of leeway for working in post
production. Also affects the histogramme (the English spelling) display on review. Works for JPEG
and RAW shooting. Has been a feature of the display of Olympus mirrorless cameras for many
years - with due respect to some Olympus Visionaries who claim their friend “discovered” this.
This PDF was originally downloaded at no charge from www.flightlevel42.co.za
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Mode Guide>Off
If set to on each time you select a new menu option or turn the mode dial a little box detailing the
purpose of the menu option or setting will appear. I kind of know mos tof them so I have it off. But
turn it on and never claim the Olympus menu system is hard to understand again?
Live View Boost>
Manual shooting>On1 With this setting the viewfinder works like an optical one but with a
high refresh rate when using manual mode. I usually use manual only in a dark studio so I know my
exposure will be fine and I need to see my subject. Some Olympus Visionaries argue that you
should map Simulated Optical Viewfinder (SOVF) to a function button for use in dark areas like a
studio. Seems like a waste of a button allocation that can do other things to me given that there is
this choice. If set to On2 it will try brighten everything but the refresh rate gets very low and the
image deteriorates in low light.
Bulb/Time>On2 When framing shots in the dark for bulb exposures it helps to see what is
in the frame. Who cares about the refresh rate then?
Live Composite>Off I want to see the actual exposure as it builds up. No need for boosting
the image here.
Others>Off In normal photography I want to see the effects of exposure adjustments as I
make them.
Frame rate>Normal/High Changes...you can only use this adjustment if you do not have the boost
and SOVF modes activated elsewhere. Normal and auto adjustment is usually great but when
shooting sports/fast action I put boost and SOVF off so I can get the fastest EVF refresh rate.
Art LV Mode>Mode1 On mode1 you see the exact effect in the EVF of the ART filter you are
using but sometimes the refresh rate drops to show it. If you use Mode2 it is the fastest EVF refresh
rate but the effects are not as pronounced and not always what you eventually get.
Flicker reduction>Auto You set different Hz values to compensate exactly for the flicker of neon
tubes and display screens but I have found that Auto does a fine job.
LV Close Up Mode>Mode2 When you enlarge an area in Live View this Mode2 setting will leave
the view enlarged and perform AF when you press the shutter button without changing the enlarged
view. In Mode1 it flips back to the reduced size view when you press the shutter button.
Depth of field preview lock>Off Pretty obvious this one. I like to press the preview, check what
the depth of field effect is and have the aperture go back to wide-open for a nice bright view when I
let go. Less to remember. Your choice may be different.
Peaking Settings
Peaking Color>Yellow You can choose from Red, Black, White and Yellow. I find yellow
to be the most consistently visible colour with most subjects.
Highlight Intensity>Normal Different intensities of peaking marking. Normal works for
me.
Image Brightness Adjust>Off If On the image intensity varies as peaking is displayed.
Backlit LCD>30 sec Saves battery power. Hold keeps rear display on as long as the camera is on.
Sleep>3 min Camera goes into low power consumption mode after the time you set here. Touch
shutter or OK to wake it up.
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Auto Power Off>4 h The camera switches off after the period of inactivity set here. You need to
cycle the power switch to get it going again if it goes into power off mode.
Beep>Off Focus confirmation and self-timer beeps. If you like drawing attention to yourself leave
it on.
USB Mode>Auto When you plug the camera into a USB device this setting calls up a menu on the
rear display for you to decide which USB mode to use. If you never connect to flat screens, data
projectors or use tethering and only plug into your computer to download images, set it to
Menu Recall>Recall If you de-activate the Recall option then you will always have to start
navigating the menu system from the first tab and first option. However, if you set this to Recall
you then have a further “soft programmable” button on the camera.
If you need to call up a particular menu option to chop and change it while on a specific shoot, press
Menu and navigate to the setting. Now touch the shutter button. Each time you press the Menu
button – even after you switch off the camera and power it on again – the last menu option you used
(in this example that special option you need to access rapidly for your shoot) will always be
recalled for quick access. Neat.
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Option set E (For Exposure/Metering/ISO)
EV Step>1/3 Sets how it increments values with each click of a control dial. On this setting count
thee clicks for each full stop of compensation.
Noise Reduction>Auto Choices are Off, On or Auto. If you shoot mainly JPEG then Auto is good.
It kicks in when you use slow shutter speeds or the camera and sensor temperature rises.
Noise Filter>Standard Sets the amount of filtering undertaken at high ISO values.
ISO>200 This setting can be accessed on the SCP. See notes below on ISO Auto.
ISO Step>1/3 Same as EV step on my camera.
ISO Auto Set
High Limit>5000
Default>200 ISO
Auto>P/A/S
The auto ISO setting is a great tool if you cannot be bothered to set ISO for each particular subject
and condition you encounter. You can decide which modes use auto ISO and you can define the
parameters of the Auto algorithm's range of options to use. The Default ISO you set should be 200.
The camera will always use that and only increase the ISO if the lower shutter speed limit set in
flash sync settings is reached. And it will only increase as far as it needs to to maintain the lower
limit you set.
While I use this on P/A/S settings, you could turn manual into an automatic mode. If, for example
you want to use 1/1000 sec at F=1:8.0, you can set that on manual mode. Now, if you set the ISO
settings shown here the camera will change the ISO to ensure that you get good exposures with
your settings but it will not exceed the maximum ISO you have set. I use ISO 5000 as I have
consistently found that to deliver good, sharp images with good colour and not too much break-up
on well-exposed images on the original E-M1.
Metering>ESP Available on the SCP. Set to taste. .
AEL Metering>Spot Sometimes this will change to SpotHi or SpotSh. What this does is it
instantly changes the metering area to a spot, SpotHi or SpotShadow mode when you press the AEL
button. See the options for AEL earlier.
BULB/TIME Timer>Variable This sets the maximum time available for Bulb photography.
BULB/TIME Monitor>-7 Sets how bright the monitor will be when you are shooting with BULB
or Live Time settings. It is usually dark so I turn it down by default. If you need it brighter you can
do this on location as required.
Live BULB>Off (usually) If off the camera builds up the image and you see it only after
completion. This saves battery power. If On, you can monitor the image as it builds-up.
Live TIME>Composite settings
Anti-Shock>
Composite settings>
The time you set is the time interval at which updates will be made to the display. Total exposure
time is the time between your first shutter press and the next one which ends the composite image
exposure.
This PDF was originally downloaded at no charge from www.flightlevel42.co.za
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Option set F (Flash Custom settings)
Flash X-Sync>1/320 Its the fastest you can use with electronic flash units unless they are Olympus
FP mode compatible.
Flash Slow Limit>1/15 This changes sometimes but this is a good floor limit in my experience.
Flash/Exposure compensation>Off If this is on, any adjustments you make to the flash exposure
compensation are added to the EV value you may have adjusted for exposure. This often gives you
over-exposed images as it racks up the ambient and the flash exposure at the same time but you will
only get a preview of the ambient exposure in the EVF. As you can quickly set flash compensation
with the multi-function lever to position 2 and top left buttons or using the SCP, I leave this off.
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Option set G (Picture quality/Colour/White Balance)
Image size settings (That pixel graphic)
1>LF
2>LN
3>MN
4>SN
Pixel Count
M/Middle>3200x2400
S/Small>1280x960
These give me great fast JPEG output options for use when shooting things only for web or
Facebook use. Seldom used but save a lot of fiddling when they are needed.
Shading Compensation>On Keeps older lenses and non 43 glass images from showing vignetting.
WB>As needed. Change via SCP or multi-mode lever position 2 and a dial. It's faster.
ALL WB Compensation>
All set
All reset
This applies the same WB shift adjustment to all WB modes or resets them to factory default.
WB Auto Keep Warm Colours>On
In Africa we like warmer tones. Your mileage may vary. Use if a JPEG shooter, immaterial if you
only shoot RAW.
Flash White Balance>WB Auto You can change the WB of the image to any setting if using flash.
Or you can leave it alone as I do as its easier to play with these things via the SCP.
Colour Space>Adobe RGB
If you only shoot JPEG and view image son a phone or PC screen out the camera, then sRGB is a
good setting to use. If you shoot RAW or work commercially, use Adobe RGB as it has a wider
colour gamut than sRGB. However, images tend to look “flat” compared to sRGB on the same
system until post processed.

This PDF was originally downloaded at no charge from www.flightlevel42.co.za

14

MARK D YOUNG's Olympus OM-D E-M1 (original model) default menu settings

Option Set H (Record and Erase settings)
Quick erase>Off
Asks you to confirm deletion of an image with a default answer of No. One day you will be glad
this is off.
RAW+JPEG Erase>JPEG
When shooting news events I shoot RAW and JPEG. JPEG for the news service and RAW for my
library. If I get accosted by an overly self-important policeman or security official demanding that I
erase a photo I may have taken, then this deletes the JPEG but not the RAW file and keeps them
happy.
File Name>Auto
This setting remembers the last file name and number on any previous card and increments it on a
new card. Prevents you landing up with hundreds of images with the same file-name which is what
happens if you choose Reset.
Edit Filename>
sRGB> (First position) M
AdobeRGB>(First position) M
This puts the letter or number you choose in the file-name at the position chosen. When shooting
several folk from my studio using the same cameras this is a handy way to differentiate who shot
what.
Priority Set>No If set to No this will put the cursor on the position you move to or a default
negative when you choose to change something. If ON the camera will automatically move the
cursor to a point that will complete the chosen action if you press OK. I need the added time to
move cursors to make sure it is a good idea before I press OK. You may feel differently.
dpi Settings>350dpi Saves you having to scale everything from a huge 72dpi file to get print ready
files.
Copyright Settings>
Copyright Info>On Adds the copyright detail you supply in the next two fields to the EXIF
data of the file. If you make money off your photos (and even if you do not) it is worth using this.
Artist Name (Your name)
Copyright Name (Your website or copyright file/link/warning or whatever...)
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Option set L (Movie settings)
Movie Mode>A I like controlling depth of field in movies/video hence this choice.
Movie mic recording>On Leave this on as it automatically cancels use of the built-in mic when
using an external one anyway. But if you forget to take one along the built in mic is not that bad out
of wind.
Movie Effect>On The camera can add ART filters to footage. Leave this on and you can use that
facility. If you do not choose them its no problem but one less thing to try and work out in the field
if you ever decide to get arty.
Wind noise reduction>Off I use an external mic with windsock most of the time hence this
choice.
Recording volume>
Built-in>Adjusted as needed
External>Adjusted as needed
Line-in>Adjusted as needed
Volume Limiter>On There is a very effective distortion limiter on this system and youhave a live
levels monitor on the screen. A good combination.
PCM Recorder/Link>
Camera Rec Volume>Operative Controls the levels on the PCM recorder using the camera
level inputs/volume control.
Slate Tone>On
Synchronised Rec>On
Movie Shutter Function>Mode1 Takes a photo when you press the shutter button during video
recording. This pauses the recording and takes a fullr es JPEG in 16:9 format then carries on
recording.
Time Code Settings>
Count up>Rec Run Counts only when camera is recording. Free run will have a time code
whizzing away on the monitor even if you are not recording.
Starting time>
Reset
Manual Input
Current time
Lets you set an arbitary time for the time code, carry on from the previous clip or use a zeroed one.
Movie Info Settings>
All selected
Items you tick here display on the movie recording monitor. You may like less information. Un-tick
as you please.
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Option set J (Built in EVF)
Built in EVF Style> Style 3 Gives maximum real eatate to the image and overlays data selected.
You also have choices to make it look like an old fashioned SLR finder.
Info Settings>
Basic Information
Custom 1
Custom 2
You need this on the custom settings if you want to see the red and blue highlight/shadow overlay
when you toggle the INFO button described earlier.
Displayed Grid>Off As I said before, if I do not know where the thirds are by now...
EVF Auto Switch>On Very kindly activates the EF for you when your eye is nearby and powers it
down again when you take the camera from your eye. Saves power and you having to press the
EVF/Live View button next to the viewfinder..
EVF Adjust>
EVF Auto Luminance>On
Automatically adapts the EVF to prevailing lighting conditions. Otherwise if off it is a constant
brightness level which can be dazzling in dark wedding venues, theatres or when shooting floodlit
sport.
EVF Adjust> Zeroed
I have found the EVF to be pretty accurate in colour and White Balance. You may wish to fiddle
though...
Halfway Level>On
S-OVF>Off
If you want things to look like they do through a flappy mirror camera viewfinder and lose exposure
preview and all the other great mirrorless advantages, set this on. There are other ways to get SOVF
quickly. One is via the Fn2 button and a dial twirl. Far faster.
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Option set K (Utility)
Pixel mapping
This takes a look at all the pixels and checks their response. Dead or stuck pixels are then mapped
out of the photographs. I do this before all important assignments.
Exposure shift>
ESP>0
CWA>0
Spot>0
If you reckon the built in meter is off, you can adjust the response of the meter here. My view is that
with the histogramme adjustments we made earlier this is not all that vital.
AF Focus Adjust>On One of my top-pro 4/3 lenses was back-focusing a tad so I adjusted it. If this
is off that adjustment is useless. If you are happy with your lenses AF performance, leave this alone.
Battery warning level>+1 Makes the battery warning pop up earlier than if at 0. My own
preference. Your mileage can vary as can your setting of this.
Battery Priority> PBH Battery If you use the HLD7 on the camera, this setting makes the camera
drain the battery in the grip first then switch to the camera in the body. You can make it use the
camera battery first but the logic of that escapes me.
Level Adjust This allows you to re-set the level indicator. Never had to do it yet.
Touch screen settings>On You may not want this on. I love the speed of settings with the SCP and
touch screen.
Electronic Zoom Speed>
Still picture>High When doing stills with a powered zoom, I like changing focal length
quickly.
Movie>Low On movies, you usually use a slower zoom tempo than with stills. You have
options though.
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Setup menu
Date and time> As you require. Local is sensible.
Language>English
Monitor Adjustments>Zeroed I find the monitor and EVF pretty good right out the factory. If you
wish, you can change the settings here but personally I never do fine review on the camera anyway.
Its far more important to have your computer monitor and other downstream items colour matched.
Rec View>OFF!!!! If this is on, each time you take a photo the EVF will display it for a fraction of
a second. No hope of following subjects then. This is on by default on the original E-M1. Do not
know why.
WiFiSettings
WiFi Connect settings>
Private / One time / Select / Off
Private will keep the details of your camera on your OI share equipped phone for a fast set up next
time it is used. One time lets you set up a fast, one time connection to any other wifi device. Select
is tedious as it asks you each time WiFi is activated if you want a Private or One Time connection.
Off is...well...off. No WiFi.
Private Password You can set your own password here. Each body has its own one so
cannot see whay you would need to but anyway...do it here.
Reset Share order This resets the way images are sent out of the camera. Frame last frame
onwards to all on card.
Reset WiFi settings All WiFi gadgets need this occasionally. However, in 5 years my
cameras have not needed it...yet.
Advanced settings (Gears) and Olympus PenPal menu display>
Gears menu>On You will want to be able to set all those amazing options on your camera.
If you cannot see the Advanced setup menu (Gears menu) activate it here.
PENPAL display>Off Unless of course you use the PENPAL gadgets and the power port.
Firmware>4.5 The latest update at time of writing. Anything less and you should connect your
camera to your PC and run the updater.
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